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                           Welcome to Freemind 
This chapter introduces you to the mind mapping 
software application Freemind (version 0.8.0). It 
provides an overview of the application and explains 
the general features of Freemind. You will learn 
about installation and configuration, installation 
prerequisites, and usage techniques.  
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1.0 Introduction to Freemind 
  

Freemind is an open source, mind-mapping software 
program written in Java. A mind map is a knowledge 
organization tool used to elicit ideas from one or more users 
by placing a topic in the center of an empty space and 
branching out with related ideas. The general premise of 
mind-mapping software is that it will help you to organize, 
link, and integrate thoughts. The primary focus of a mind 
map involves making an arrangement of words into a 
picture, which has a key concept at the centre or at the top, 
and related words and concepts linked with the key concept 
by means of lines and arrows. 
 
Mind mapping software can be used for brainstorming and 
conceptualizing, where you have ideas you need to put 
down, structure, expand, and connect. Freemind also works 
as a tree editor. You can create foldable trees of plain text 
notes enriched with colors, icons, cloud-shapes, and other 
graphics. This will help you to customize your map. For 
example, you can use clouds to group together the nodes 
that are interrelated, colors to differentiate between 
completed tasks and other tasks, and icons to prioritize a 
node. 
 
Freemind is useful for organizing your ideas and for keeping 
track of all the things that are involved in completing a task. 
You can use Freemind to keep a personal knowledge base 
that is easy to manage. You can take advantage of the 
scientific method and write-everything-down approach in 
your daily life. Freemind is a valuable and effective tool for 
people who want to manage themselves systematically. 
 

1.1 What Freemind is good for 

Current users of Freemind use it for the following purposes:  

� Projects - Freemind helps you in keeping track of 
projects including subtasks, state of subtasks, and time 
recording  
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� Information – Freemind helps you in managing 
information  including links to necessary files, 
executables, and source of information 

� Internet research – Freemind helps you in performing 
internet research using Google and other sources  

� Knowledgebase – Freemind helps you in keeping a 
collection of small or middle-sized notes with links on 
some area, which expands as needed. Such a collection of 
notes is sometimes called a knowledge base 

� Essay – Freemind helps you in writing essays and 
brainstorming your ideas, using colors to show which 
essays are open, completed, not yet started etc, using size 
of nodes to indicate size of essays 

� Database – Freemind helps you in keeping a small 
database of something with structure that is either very 
dynamic or not known in advance 

� Internet favorites – Freemind helps you in maintaining 
commented internet favorites or bookmarks, with colors 
and fonts having the meaning you want 

 

1.2 Features 
 

Freemind is an excellent application for mind mapping and 
brainstorming your ideas. What makes it so different from 
other mind-mapping applications? The main difference is its 
usability. The presence of a simple and intuitive interface 
makes the application easy to use and understand. It can be 
almost fully controlled by the keyboard.  
 
The Freemind (version 0.8.0) application has a set of unique 
features: 
 
� Folding – This is the ability of Freemind to hide or 
display all the information below a selected node. Easy 
control of folding is an essential property of Freemind. 

� Navigating with a single click – This also includes 
folding / unfolding with one click and following links 
with one click at the same time. You can move the map 
by dragging the map's background or by using the 
mouse wheel. 
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� Following of HTML links – HTML links can be stored in 
the nodes, including the World Wide Web links and links 
to local files. 

� Using Undo – The Undo feature is used to remove the 
effect of a previously used menu option. 

� Smart Dragging and Dropping – This includes the 
possibility of copying nodes or styles of nodes; dragging 
and dropping of multiple selected nodes; dropping of 
texts or list of files from outside. 

� Smart copying and pasting – This feature helps in 
pasting of links from HTML or structuring the pasted 
content on the basis of the number of leading spaces in a 
line; pasting of lists of selected files. 

� Exporting your map as HTML – This feature converts 
your mind map to a standard, hierarchical text structure. 

� Using the Find facility – This feature displays the found 
items one by one on selecting the “find next” option. The 
map is unfolded only for the current item. 

� Using Built-in icons – Built-in icons can be used with 
colors and different fonts to decorate nodes.  

� Storing maps in XML format – Freemind exhibits low 
cost of risk of switching away to another mind mapping 
tool, because Freemind stores maps in XML format. If 
you have a lot of maps created by Freemind and you 
want to switch to another program, writing a conversion 
program should be easy, especially if that program 
features Visual Basic scripting facility. 

� Using the File mode – The File mode can be used to 
browse the files on your computer, seeing the folder 
structure as mind map. 

 
Freemind has an edge over many other applications because 
it can be easily customized and has an extensive set of 
features. The entire process of creating, using, and sharing 
mind maps is made very user friendly. From a practical 
point of view, Freemind does allow you to try out a different 
way of structuring and visualizing content. By visualizing 
your content and its various connections in a fluid way you 
may be able to gain a better grasp of it all. All these 
characteristics have helped in increasing the popularity of 
the application. 
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2.0 Installation 
  

This section provides details about the prerequisites and 
techniques to download and install Freemind. The latest 
version of Freemind (version 0.8.0) occupies 9.5 MB of disk 
space.  
 

2.1 Basic requirements of Freemind 
 

The following are the minimum requirements for using 
Freemind:  
 
� Java Runtime Environment (JRE) version 1.4.2 
 
� Windows, Linux, or Mac operating system 
 
� Internet connection 
 

2.2 Downloading and installing JRE 

  
This section provides details regarding downloading and 
installing JRE 1.4.2 in the Microsoft Windows environment. 
You must first install JRE 1.4.2 and then install Freemind. 
Kindly verify your system requirements before downloading 
JRE.  
 

 System requirements 
 

� Approximately 200 MB of disk space. 
� Windows 98, Windows ME, Windows NT 4.0, Windows 
2000, or Windows XP. 

� This installation requires Windows Installer 2.0 on your 
machine, or an Internet connection for it to be 
automatically downloaded. 

� A Pentium 166MHz or faster processor with at least 32 
megabytes of physical RAM is required to run 
graphically-based applications. Intel or a 100% 
compatible processor is supported. 
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� The Supported Browsers are  

�  Netscape 4.7.x, 6.2.2, or 7  
�  Mozilla 1.2.1, 1.3, 1.4, or 1.4.1  
�  Internet Explorer 5.5 (SP2+), or 6.x. 

 

Downloading and installing JRE 1.4.2 for 
Microsoft Windows using Internet Explorer 
 
1.   Enter the following link in your browser: 
      http://java.sun.com/j2se/1.4.2/download.html 
       
2. Go to the section J2SE v 1.4.2_10 JRE. Click on 
      Download J2SE JRE. 
 
      The Download section for Java(TM) 2 Runtime                                
Environment, Standard Edition 1.4.2 opens. 
 

3.   Review the license agreement and click Accept. 
 
If you are not satisfied with the terms and conditions, 
and you do not click Accept, it is not possible to 
download JRE 1.4.2.      

 
4. Click Windows Offline Installation, Multilanguage. 

 
5. Select Save in the dialogue box that opens. 

 
This saves the downloaded file without installing it. 
 

6.   When the download completes, click Open. 
 
The file j2re-1_4_2_<version>-windows-i586.exe 
contains everything needed to install the Java 2 Runtime 
Environment, including the installer, character 
conversion classes, and support for locales other than the 
US English locale. 
 

7.   Run the file downloaded in step 6 by double-clicking the 
installer's icon. Follow the instructions the installer 
provides. Click I accept the terms in the license 
agreement and click Next. 
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 You cannot download JRE 1.4.2, if you do not accept the 
terms and conditions. 

 
8. In the Setup Type section, by default the Typical setup is 
selected. Click Next. 

  
 The Typical setup installs all the recommended features. 
 
9.  Click Finish, when the Install Shield Wizard completes 
the installation.  

 
10. When done with the installation, you can delete the 
downloaded file and recover the disk space.       

 

2.3 Downloading and installing Freemind 
 

This section provides details regarding downloading and 
installing the Freemind application in the MS Windows 
environment. Kindly verify your system requirements 
before downloading Freemind. 
 

System requirements 
 
� 9.5 MB of disk space. 
� Freemind works with Windows 95, Windows 98, 
Windows NT, Windows 2000, Windows XP (SP1 & SP2), 
and Windows 2003 Server. 

� The Supported Browsers are  

• Netscape 4.7.x, 6.2.2, 7  

•  Mozilla 1.2.1, 1.3, 1.4, 1.4.1  

•  Internet Explorer 5.5 (SP2+), 6.x. 
 

Downloading and installing Freemind for 
Microsoft Windows  
 
1. Enter the following link in your browser:      
 http://freemind.sourceforge.net/wiki/index.php/Mai

n_Page 

 

2.   Go to the Download section and click Windows Installer   
Max available under Microsoft Windows. 
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A download window stating Opening Freemind- 
Windows-Installer-0_8_0-max.exe opens. 
 

3. Select Save to Disk and click OK. 
 
4. Once the download is complete, click Open. 

 
The Freemind Setup Wizard launches. 
 

5. Follow the instructions of the Setup wizard to complete 
the installation. 

 
6. Once the installation is complete, double click the file 
Freemind.jar which is an Executable Jar File located in 
the folder lib to run the application. 

 
 
Note: You can also download Freemind by selecting 
http://freemind.en.softonic.com/ie/34379 and 
clicking Download (Free version). 
    OR 
An alternate location to download Freemind for free 
is http://www.mapyourmind.com/freesoftware.htm. 
Scroll down the page and click Download 
Freemind. 
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                           Getting Started 
This chapter explains the basic interface of Freemind. 
It provides details about working with nodes and 
creating mind maps. You will learn about editing, 
formatting, and applying patterns to a node by 
working with physical styles. The primary objective 
is to help you learn the basics of Freemind. 
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3.0 Exploring the Freemind interface 
 

It is very important to be familiar with the Freemind 
interface to understand the basics of Freemind. The interface 
of Freemind has 3 main components: 
 
1. The Menu bar 
2. The Formatting bar 
3. The Icon toolbar 
 
 

                                      Menu bar       Formatting bar     Font pull down 

Name of the 

current map 

 

 

 Icon toolbar         Root node         Child nodes     Node with formatting       Web link  

 

                            Figure 1 The Freemind Interface                                                                                               

 
You will be exploring each of the toolbars in detail in the 
upcoming sections. 
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Freemind operates in the “mind map” mode. Before creating 
a new mind map, you should be aware of some common 
terminologies used in Freemind. A node is a text box that is 
used to store information. Nodes are connected together 
using curved lines called edges. When you create a new 
mind map in Freemind, you will notice a grey, oval shaped 
node with a label “New Mindmap”. This is the root node. 
You will build your map by adding nodes to the root node. 
The root node is currently selected when it is highlighted in 
grey color. Clicking on it will open the text for editing. 
 
A child node originates from the parent node and is 
positioned 1 level lower than the parent node. A sibling 
node is positioned at the same level as its reference node. For 
example, when a sibling node is created for a child node, it is 
positioned at the same level as that of the child node. A root 
node can only have child nodes. Other nodes can have both 
child and sibling nodes. 
 
As you build your map, you can set colors, sizes, fonts and 
other attributes to emphasize nodes and edges. This helps 
you to customize your map. For example, you can use 
clouds to group together the interrelated nodes, colors to 
differentiate between completed tasks and remaining tasks, 
and icons to prioritize a node. 
 
Nodes can be "folded" or "unfolded" by clicking on them. 
Unfolding a node displays the nodes below it. You can also 
insert, delete, and rearrange nodes quickly. Most of the 
options also have keyboard shortcuts.  
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3.1 Creating and deleting nodes 
 

Create a new mind map by working with nodes and edges. 
Create a mind map called “Writing an article”.     
 

Creating nodes 
 

 1.   Click File in the menu and select New. 
 
 A new screen having a root node labeled as “New 
Mindmap” opens. 

 
2. Click the root node to change the name. Erase “New 
Mindmap” and enter the title of your map. In this 
example, enter the text “Writing an article”. 

 
3.  Go to Insert, and click New Child Node.  
 
 Freemind inserts a new child node to the root node. 
 
 
 
 
 
4. Click the grey area to open the text editor. Assign a name 
to your child node. In this example, enter the text “Topics 
to cover”. 

 
5. Select the node “Topics to cover” by clicking on it. Go to 
Insert in the menu and select New Sibling Node. 

 
 A sibling node opens at the same level as that of the node 
“Topics to cover”. 

 
 
 
 
 
 
6. Click the grey area to open the text editor. Assign a name 
to the sibling node. In this example, enter the text “Items 
needed”.  

 

Note: To create a child node while editing another 
node, press Insert while editing. 

Note: To create a sibling node below the active node, press 
Enter. To create a sibling node above the active node, press 
Shift+Enter. 
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7. Create 4 more child nodes to the root node. Label the 
newly created child nodes as “Type of article”,” Due 
date”, “Audience”, and “Sources”. 

 
8. Enter the following sub-categories of information for 
every child node of the root node: 

 
Child Node Sub-categories 

Topics to cover Introduction, overview, 
detailed examples, analysis of 
examples, conclusions drawn, 
wrap up, and author 
information 

Items needed Other articles on the subject, 
sample products, list of 
potential interviewees, and 
contact information for 
publication 

Due date Deadline for text, number of 
words, deadline for artwork, 
and print date 

Type of article Editorial, review, 
comparison, industry 
analysis, and opinion piece 

Audience Experts, consumers, and 
other writers 

Sources Research, interviews, product 
review, and industry statistics 
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9. Compare your mind map with the map given below: 

                             Figure 2 The “Article” mind map 

 
Deleting nodes 
 
1. Place your mouse pointer over the grey area of a node. 
 
2. Press Delete. 
 
Right clicking a node and using the node context menu can 
also be used to perform most of the editing, inserting, and 
formatting operations. 

 
3.2 Saving your mind map 

 
1. Go to File in the menu bar. Select Save As. 
 
 The Save As dialogue box opens. The Save As option is 
preferred because you should assign a name and a 
location to store your map. 

 
2. Browse to choose an appropriate location in Save In 
section to save your mind map. Enter a filename and 
click Save. 
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Your mind map is saved in the selected location. By 
default, mind maps will have the file extension”. mm”. 

 

3.3 Editing node text 
 

You can perform many operations to edit the text in the 
nodes. Here is a set of the commonly used editing 
operations. 
 

Editing a node 
 
To edit a node, press either the F2/END/HOME key or 
choose Edit from the node context menu. To finish editing a 
node, press Enter. 
 
Replacing existing text 
 
Place your cursor over the grey area of the node, and start 
typing the new text. This will replace the existing text with 
the new text. 
 

Forcing the long node editor 
 
To force the long node editor when editing a short node, 
press Alt+Enter. 
 

Splitting the long node 
 
You can use the Button Split option to split the text in the 
long node editor. 
 
1. Place your curser on the grey area of the long node. Right 
click and select Edit Long Node option. 

 
 The Edit Long Node dialogue box opens. 
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                              Figure 3 The Edit Long Node Dialogue Box 

 
2. Place your curser at the point where you want to split the 
long node. Select the option Split. 

 
The long node text splits between 2 separate child nodes. 
 

Inserting a new line in the long node editor 
 

To insert a new line in the long node editor, press 
Control+Enter. 
 
 

 
 
 
 
 

 
 
      

 

 

 

 Copying 
  

You can copy a selection to the clipboard while editing a 
long node. Right click the selection and choose Copy. 
 

Inserting special symbols 
 
You can insert symbols in Freemind by inserting the symbol 
into MS Word or any other text editor. Finally, copy the 
symbol from the text editor to Freemind. 
 

Note: You cannot insert a new line in the short node 
editor. By default, Control+Enter inserts a new line 
and Enter finishes the editing of a long node. You can 
reverse the functions of these key combinations by 
unchecking the Enter Confirms option in the Edit 
Long Node dialogue box. In this way, Control+Enter 
finishes editing and Enter inserts a new line. You can 
set the default value of the checkbox in Preferences. 
The value of the box is saved during a session of 
Freemind. 
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Freemind fully supports Unicode. Unicode is a standard for 
identifying letters and numbers that attempts to include 
character sets from all languages around the world. Thus, 
you can use the script of your choice. 
 

3.4 Formatting a node 
 

Formatting is the process of adjusting the color, size, font, 
shape, and many other attributes of the node. Formatting 
helps you to distinguish between different types of nodes 
and their information. For example, you can use variable 
font to highlight different levels of text, colors and shapes to 
categorize nodes, and modify the node and edge styles to 
suit your needs. Freemind has a set of formatting options as 
discussed in this section. 

 
Applying styles to your nodes 
 
You can apply the Fork or Bubble styles to your nodes. The 
difference between the two styles is just a visual 
presentation. The Bubble style uses an oval shaped bubble to 
enclose the data of a node, whereas the Fork style holds the 
data without any enclosure. 
 
Applying the Fork style 
 
1. Select the node where you want to apply the style. Click  
Format in the menu. 

 
 Freemind opens the Format options. 
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                     Figure 4 The Format Option 

 

2.   Select the option Fork. 
 
 The selected node takes the shape of a fork. 
 
Applying the Bubble style 
 
1. Select the node where you want to apply the style. Click  
Format in the menu. 

 
 Freemind opens the Format options. 
 
2.  Select the option Bubble. 
 
 The selected node takes the shape of a Bubble.  
 

Formatting the text 
 
Using the bold option 
 
Select the node of your choice and press Control+B. You can 

alternately click “ b “ in the formatting bar. 
 
Using the italics option 
 
Select the node of your choice and press Control+I. You can 

alternately click “ i “ in the formatting bar. 
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Changing the font family 
 
To change the font family, use the field in the formatting 
toolbar. 
 
Changing the font size 

 
1. Select the node where you want to change the font size. 
Click Format in the menu. 

 
 Freemind opens the Format options. 
 
2. Click Larger Font or Smaller Font depending on your 
choice. 

 
 Freemind updates the changes in font size. 

 
Using the coloring options 
 
You can change the colors of the node text, background, and 
edges based on your choice. 
 
Changing the color of the node text  
 
1.   Select the node to change the text color, and choose 
Format in the menu bar. 

 
2. Click  Node Color option. 

 
  The Choose Node Color dialogue box opens. 

         Figure 5 The Choose Node Color Option 
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3. Select the color of your choice. Click OK. 
 
Freemind changes the color of the text in the selected 
node. 

 
Changing the background color 
 
1. Select the node to change the text color, and choose 
Format in the menu bar. 

 
2. Select the option Node background Color. 
 
The Choose Node Background Color dialogue box 
opens. 

 
3. Select the background color of your choice and click OK. 
 
 Freemind changes the color of the background in the 
selected node. 

 
  

 

 

 

 

 

 
Using the Blend Color option 
 
Select the node of your choice. Go to Format and choose 
Blend Color. You can alternately press Alt+B. 
 
The node text color blends or merges with its background. 
 

Using the Automatic Layout option 
 
The Automatic Layout option fixes the layout of your map. 
It assigns some pre-defined colors to represent the different 
stages of your mind map. The default colors are black for the 
first level and blue for the second level of your map. 
 

Note: You can also remove the node background color 
by clicking the Remove Node Background Color 
option in the Format menu. If adding the background 
color was your immediate operation in the past, click 
Undo to remove the background color. 
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To use this option, go to Format, and select Automatic 
Layout. 
 

Creating a Blinking Node 
 
You can create a blinking node. It is not advised to use this 
option repeatedly and not with other automated formatting 
to the same node, as a blinking node can be distracting.  

 
To use this option, go to Format, and select Blinking Node. 
 
Modifying the edges 
 
You can modify the color, style, and width of the edges 
using the Format menu. 
 
 
Modifying the edge color 
 
1. Select the node which you want to modify. Click Format 
and choose Edge Color. 

 
 The Choose Edge Color dialogue box opens. 

                Figure 6 The Choose Edge Color Dialogue Box 

 

2. Select the edge color of your choice. Click OK. 
 
Freemind changes the color of the edge of the selected 
node. 
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Modifying the edge style 
 
1. Select the node which you want to modify. Click Format 
and choose Edge Style. 

 
 Freemind gives you 4 different styles as options. They are 
Linear, Bezier, Sharp Linear, and Sharp Bezier. 

 
2. Click the style of your choice. 
 
Freemind changes the style of the edge of the selected 
node. 
 

Modifying the edge width 
 
1. Select the node which you want to modify. Click  Format 
and choose Edge Width. 

 
Freemind gives you 6 different options. They are Parent, 
Thin, 1, 2, 4, and 8. 
 

                     Figure 7 Adjusting the Edge Width 

 
2. Click the width of your choice. 
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Freemind changes the width of the edge of the selected 
node. 
 
 
 
 

 
 

3.5 Using the Physical Styles 
 

The physical style is called “Patterns” in Freemind. Most 
patterns encompass typeface variations, such as style, font, 
and size. But patterns can also be designed to include links 
to images, files, and programs. 

    

 Applying the Physical Style 
 

1. Select the node of your choice. Go to Format, and click 
Physical Style. 

 
Freemind opens the options in Physical Style.  

                     Figure 8 The Physical Style Options 

 

Note: Right clicking the node context menu and 
selecting Format can also be used to perform most of 
the formatting options. 
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2.   Select the physical style of your choice. 
 
 Freemind applies the selected style to the node. 
 
 

 

  

 
 
More information about Patterns 
 
The file “patterns.xml” located in the folder “Freemind” of 
your home directory has the code for every physical style. 
You can add your own physical style by editing the code in 
the file “patterns.xml”. 
 
 If your code has a <node> tag, then the pattern applies to a 
node. If your code has an <edge> tag, then the pattern 
applies to the edge. A typical pattern in patterns.xml looks 
like this: 
 
<pattern name="Folder"> 

    <node color="#CC9900"> 

        <font NAME="Arial" size="14" /> 

    </node> 

</pattern> 

 
Note that the <node> tag has the <font> tag as a child.  The 
<font> tag itself is terminated by the "/" at the end.  
You can have a simple pattern that only changes the color: 
 
<pattern name="Purple"> 

    <node color="#993399"/> 

</pattern> 

 
A tag can include imbedded links. In this case, it's necessary 
to use the "&" codes for special HTML characters. The 
following example loads the node with a graphic that has 
been stored in Freemind's images directory. 
 
<pattern name="Question mark"> 

    <node TEXT="&lt;html&gt;&lt;imgsrc=&quot;file:/// 

C:/ProgramFiles/FreeMind/Images/question.gif&quot;&gt

;&lt;/html&gt; "> 

<font NAME="Default" SIZE="14"/> 

    </node></pattern> 

Note: Right clicking the node context menu and 
selecting Physical Style is an alternate method to 
add physical styles. 
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Be aware that the use of the "text" attribute, whether to insert 
actual text or HTML code, will completely overwrite any 
text that was already in that node. If you're using the 
shortcut keys, remember that the patterns are numbered 
simply according to their sequence in the list. So if you add 
or delete a pattern in the middle, the numbering will change. 
 

3.6 Searching nodes 
 

The Find option in Freemind searches a node and its 
descendants. The search is a breadth-first search.  
Breadth-first search corresponds to the idea that the deeper a 
node, the greater is the detail described in the node. By 
default, the searching process is not for the whole map. It is 
only for a particular node and its descendants. 
 

Searching nodes and their descendants 
 
1. Place your curser over the grey area of a node. Press 
Control+F. Alternately, choose Find from the Edit menu. 

 
 The Input dialogue box opens. 

                                                          Figure 9 The Find Option  
  

2. Enter the text you want to search. Click OK. 
 
Freemind finds the particular node having the desired 
text. 
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Finding the next match of your previous search 
 
After performing the first search, press Control+G. 
Alternately, you can also choose Edit, and select the option 
Find Next. 
 
Freemind will display the node with contents matching your 
previous search. 
 

Searching the whole map 
 
1.  Position the node to the root node by pressing ESC key 
before searching. Press Control+F. Alternately, choose 
Find from the Edit menu. 

 
 The Input dialogue box opens. 

           Figure 10 The Find Option 

     

2.  Enter the text you want to search. Click OK. 
 
Freemind finds the particular node having the desired 
text by searching the entire mind map.
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Chapter 3 
 
                                                    

 

 

 

 

 

 

 

 

 

 

                       Adding Clouds, Links and 
                       Icons 

This chapter explains the procedure for highlighting 
your nodes with clouds. You will learn how to add 
hyperlinks, icons, and graphical links to your nodes. 
You can create links to the local files in your system 
or any other web pages.  
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4.0 Adding clouds, links, and icons 
 

This chapter will help you to incorporate some advanced 
features such as clouds and links in your mind map.  
 

4.1 Highlighting nodes with clouds 
 

Clouds are well suited for highlighting a particular region of 
your mind map. When you apply a cloud to a node, the 
node and all its descendants are highlighted. Clouds can 
have different background colors. Highlighting nodes with 
clouds helps you to categorize information. You can use 
clouds to group together nodes having something in 
common or to highlight a section of your map. 
 

Adding clouds  
 
Select the node of your choice. Go to Insert and choose 
Cloud. You can alternately open the node context menu, 
select Insert, and click Cloud. 
 
Freemind inserts a cloud for the selected node and all its 
sub-nodes. 
 
A sample of a cloud is shown here. 

     Figure 11 Adding Clouds 
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 Changing the cloud color 
 

1.  Select the main node of the cloud of your choice, and 
right click to open the node context menu. Go to Format, 
and select the option Cloud Color. 

 
 The Choose Cloud Color dialogue box opens. 
 
2. Select a suitable color and click OK. 
 
 Freemind applies the chosen color to the node and its 
descendants. 

 

4.2 Adding hyperlinks 
 

Hyperlinks can link to web pages, local files in your 
computer, or e-mail addresses. When you move to a node 
containing a hyperlink, the mouse pointer changes to a hand 
symbol. You can add hyperlinks in 2 ways: 
 

� Text field − In this method, you will enter the URL or the 
web address of the target. When you click the node 
having this link, the particular web page opens up. 

 

� File chooser − In this method, you will select a local file in 
your system.  When you click the node having this link, 
the particular file or folder opens up. 

 

Adding hyperlinks using Text Field 
 
1.  Select a node of your choice. Click Insert and select 
Hyperlink (Text Field). 

 
 The Input dialogue box opens. 

                  Figure 12 Adding Hyperlinks using a Text Field
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2. Enter the hyperlink as given below and click OK. 
 http://www.google.ca 

  

 Freemind inserts a hyperlink in the selected node. 
 

Adding hyperlinks using File Chooser 
 
1. Select the node of your choice. Click on Insert and select 
Hyperlink (File Chooser).  

 
 The Open dialogue box appears. 

            Figure 13 Adding Hyperlinks using File Chooser 

 
 2.  Select the file you want to add as a link and click Open. 
 
       Freemind inserts a hyperlink in the selected node. 
 

 Removing a hyperlink 
 

Select Insert and click on Hyperlink (Text Field). Set the 
hyperlink to empty in the Input box. 
 
This removes the existing hyperlink in the node. 
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Linking to e-mail address 
 
1. Select the node of your choice. Click Insert and select 
Hyperlink (Text Field). 

 
2. Enter the link for e-mail based on the format given 
below: 

 mailto:johnsmith@hotmail.com 

 

Freemind confirms the e-mail link by adding a mail icon 
to the node. 

 
 
 
 

 
 
 
 

4.3 Adding icons 
 

An icon is a picture or symbol that represents a task, 
command or object. You can select the object or action by 
clicking on its icon.  
 
A node can have several icons. Freemind offers 35 different 
icons. There is no option to choose your own icon; you can 
choose from the icons offered by Freemind only. 
 
By default, Freemind displays the icon toolbar when you 
open a new mind map. The icon bar is also called as Left 
Toolbar in the menu. You can display or hide the icon 
toolbar by selecting View and clicking on Toggle Left 
Toolbar. When you choose an icon, it is inserted at the start 
of the node, but after any icons that are already there. 
 
  
 
 
 
 
 

Note: You can also add a subject to your e-mails. The 
format for the link is as given: 
 
mailto:johnsmith@hotmail.com?subject=Hello. 
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Here is a display of the available icons in Freemind. 

                   Figure 14 Icons in Freemind (version 0.8.0) 

 

Adding icons 
 
Select the node of your choice. Press either the Alt or 
Control key and slowly move your curser to the Icon 
toolbar. Click the icon of your choice. 
 
Freemind inserts the icon in the selected node. 
 

 
 
 
 
 
Removing icons from a node 
 
As mentioned earlier, a node can have multiple icons. To 
remove 1 icon at a time, select the node, and click the Red 
Cross (Remove Last Icon) at the top of the icon toolbar. 
 
To remove all the icons in a node, select the node, and click 
the trash can (Remove All Icon) at the top of the icon 
toolbar. 

 

Note: You can also add an icon to the node without using the 
Icon toolbar. Press Alt+I and select an icon from the display. 
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4.4 Adding graphical links 
 

A graphical link is a path between nodes in the mind map. 
You should select at least 2 nodes to add a graphical link. 
 

Adding Graphical Links to nodes 
 
Select 2 nodes of your choice. Press Control key to focus on 
your selection, go to Insert, and click Add Graphical Link 
option. 
 
Freemind inserts a graphical link from the first node to the 
second node. 
 
An example of a graphical link from node 1 to node 2 is 
shown here. 

                          Figure 15 Adding Graphical Links 

 
Changing the Graphical Link color 
 
1.   Select the graphical link and right click.  
 
 Freemind shows a set of options to customize the 
graphical link. 
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                                 Figure 16 Using the Arrow Link Color Option 

 
2.   Select the option Arrow Link Color.  
 
3. Choose an appropriate color and click OK. 
 
 Freemind assigns the selected color to the graphical link. 
 

Changing the arrows of the link 
 
You can change the arrow style for the graphical link by 
right clicking the link and selecting the style of your choice. 
 

Deleting a Graphical Link 
 
You can delete a graphical link by right clicking the link and 
selecting Remove Arrow Link option. 

 
Navigating to a particular node 
 
Use the link context menu to navigate to one of the end 
nodes of the link. You can accomplish this by right clicking 
the link and selecting a target node. 
 

Changing the arrow routing 
 
You can change the routing of the arrow link by dragging it 
and moving it.
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Chapter 4 
 
                                                    

 

 

 

 

 

 

 

 

 

 

                       Advanced Operations 
                                                In this chapter, you will learn about selecting multiple  

            nodes, folding, navigating , and using other     
            advanced features in Freemind. You can access  
            details regarding exporting and importing mind  
            maps. You will be learning about many advanced  
            operations such as customizing Freemind, using the  
            web applet, using rich text, and pictures in nodes.            
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5.0 Features that simplify your work 
 

Freemind has some excellent features that help you 
minimize your workload. Every user must be aware of the 
following operations: selecting multiple nodes, drag and 
drop, copy and paste, folding and unfolding, and Undo 
feature. 
 

5.1 Selecting multiple nodes 
 

When you are working with multiple nodes, you can 
perform the following functions. 
 

Selecting multiple nodes in a map 
 
To select multiple nodes in your map, hold the Control or 
Shift key while clicking. 
 

Selecting a complete sub-tree 
 
To select a complete sub-tree, press Alt, and click the main 
node of the sub-tree. You can alternately perform the 
function by pressing Shift, while moving with arrow keys 
from a node to its parent. 
 

Canceling your selection 
 
To cancel the selection of multiple nodes, click the map 
background. 
 

Selecting all the nodes in the map 
 
To select all the visible nodes, go to Edit, and click Select All 
Visible. 
 
Freemind selects all the nodes. 
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Selecting all the visible nodes of a branch 
 
To select all the visible nodes of a branch, go to Edit, and 
click Select Visible Branch.  
 
Freemind selects the visible nodes of the branch. 
 

5.2 Dragging and dropping 
 

You can move the nodes around the map using the drag and 
drop option. 
 

Dropping a node as a child 
 
To drop a node as a child, click on the node, and drag it 
slowly towards the destination node. While dropping, 
release the curser at the outer part of the destination node. 
 
Freemind adds the selected node as a child of the destination 
node. 
 

Dropping a node as a sibling 
 
To drop a node as a sibling, click on the node, and drag it 
slowly towards the destination node. While dropping, 
release the curser at the top part of the destination node. 
 
Freemind adds the selected node as a sibling of the 
destination node. 
 

Copying a node while dragging 
 
To copy a node, hold the Control key while dragging. 
 
Freemind copies the selected node to the new location. 
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Creating a Graphical Link 
 
To create a graphical link, select the first node. While 
holding the right mouse button, drag, and drop the first 
node to the target node. 
 
Freemind creates a graphical link from the first node to the 
target node. 
 
 
 
 

 
 
 

5.3 Copying and pasting 
 

You can copy and paste multiple nodes in mind maps. You 
can paste normal text or HTML from other applications. 
 

Copying 
 
You can copy a node either with or without its descendants. 
Copy and Copy Single are the available options for this in 
Freemind. 

 
Copying a node and its descendants 

 
To copy a node with its descendants, go to Edit, and click 
Copy. 
 
Freemind copies the contents of the node and all sub-nodes 
to a clipboard. 
   

 Copying a node without its descendants 

 
To copy a node without its descendants, go to Edit, and click 
Copy Single. 
 
Freemind copies the contents of only the node to a clipboard.  
 
  

Note: You can drop data into the nodes from external 
applications. This data can include pieces of text from 
Microsoft Internet Explorer or files from the Windows 
operating system. 
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The following example illustrates the concept in the Note. 
 
 

Pasting 
 

You can paste plain text, HTML, and file lists from Windows 
Explorer into Freemind. 
 
Pasting plain text 
 
When you paste plain text, multiple lines are pasted as 
multiple nodes. The positioning as a child or sibling is based 
on the depth of the text, which is determined by the number 
of leading spaces in the text. For example, consider the 
following text in MS Word. 
 
Subjects 
             Science 
             Mathematics 
             English 
                          Grammar 
 
When you paste this into Freemind, the following will  
appear. 

        Figure 17 Pasting Plain Texts into Freemind 

 

Note: When you copy a branch from Freemind and 
paste it into an editor that understands Rich Text 
Format (RTF), the formatting including color and font 
is pasted too. Hyperlinks are pasted in brackets (<>). 
Editors that understand RTF include Microsoft Word, 
WordPad, Microsoft Outlook, or some tabbed 
notebooks in Linux. 
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Pasting HTML 
 
When you paste HTML into Freemind, it is pasted as plain 
text. The links in HTML are pasted as the children of an 
additional node with text “Links”. 
 
Consider the following text in MS Word containing HTML 
links. 
 
Google 
Yahoo 
 
When you paste this into Freemind, the following will 
appear. 
 

            Figure 18 Pasting HTML into Freemind 

 

 Pasting file lists from Windows Explorer 
 
Copy some files from Windows Explorer and paste it into 
Freemind.  
 
Freemind adds a link for every file that is included. 
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5.4 Folding and unfolding 
 

A node having descendants or sub-nodes can be folded. 
Upon folding, the parent node remains intact, but the 
descendants are temporarily hidden. This concept is useful 
while working with large maps having lots of data. You can 
fold the descendants of those nodes whose data you will not 
be using. A folded node is marked with a small circle 
attached in the outer direction. 
 

Folding a node 
 
To fold a node, point the curser to the node and press Space. 
Alternately, open the node context menu and select Toggle 
Folded. 
 
Freemind automatically folds the selected node. 
 

Unfolding a node 
 
To unfold a node, point the curser to the node and press 
Space. Alternately, open the node context menu and select 
Toggle Folded. 
 
Freemind automatically unfolds the selected node. 
 

Folding or unfolding in levels 
 
When you have multiple levels of nodes, you can fold them 
or unfold them level-by-level. 
 
To fold a node 1 level at a time, press Alt+PageUp. 
 
To unfold a node 1 level at a time, press Alt+PageDown. 
 

Folding all the nodes at once 
 
To fold all the nodes in the map, select the root node, and 
click on the grey minus sign in the main toolbar. 
 
Freemind folds all the nodes in the map. 
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Unfolding all the nodes at once 
 
To unfold all the nodes in the map, select the root node, and 
click the grey plus sign in the main toolbar. 
 
Freemind unfolds all the nodes in the map. 
 

5.5 Using Undo 
 

You can use the Undo feature to cancel the result of a 
previous action. 
 
To set the number of steps kept for undoing, use in pull-
down menu Tools > Preferences. In Freemind properties 
window, click Behavior and select Undo Levels. 
 
To undo the previous task, go to Edit and select Undo. 
 
To redo the previous task, go to Edit and select Redo. 
 

6.0 Navigation features 
 

There are different techniques to navigate through your map 
in Freemind. The following are some important navigation 
features: moving around, changing to a different map, 
scrolling, and zooming. 
 

6.1 Moving around 
 

You can move around the map using arrow keys, Page Up 
and Page Down keys, dragging, and Escape key. 
 

Moving in multiple directions 
 
To move the curser up, down, left, or right, use the arrow 
keys. 
 

Moving to the top and bottom of a sub-tree 
 
To move to the top of the current sub-tree, press Page Up. 
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To move to the bottom of the current sub-tree, press Page 
Down. 
 

Moving to the root node 
 
To move to the central node, press Escape. 
 

Positioning a node  
 
To position a node freely, drag the node by the invisible 
handle placed at the side of the node in the direction of the 
root node, and move it. 
 

6.2 Changing to a different mind map 
 

Once you launch Freemind and open the different maps you 
want to work with, you can switch around between the 
maps. Fast switching among maps can be done by one of the 
following methods. 
 
� Right-click on an empty area of the map, and select the      
     map name. 
� Go to Maps in the menu. Choose Previous Map or Next          
      map. 
� Press Control+Left arrow or the Control+Right arrow. 
 

6.3 Scrolling the map 
 

You can scroll the mind map by one of the following 
methods. 
 
� Scroll the map by using the standard scroll bars. 
� Drag the background and move it in the desired 
direction. 

� Scroll by using the mouse wheel. To scroll horizontally, 
hold the Shift key or one of the mouse buttons and move 
the mouse wheel. 
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6.4 Zooming 
 

 You can zoom by one of the following methods. 
 

� Use the zooming field in the main toolbar. 
� Use the mouse wheel while holding the Control key. 
� Press Alt+Up arrow or the Alt+Down arrow. 
 

6.5 Following links 
 

You can follow a link by clicking the node.  
 
On a node with a link and children, click the left side of the 
node to open a link. Click the right side of the node to fold or 
unfold the tree. 
 

7.0 Exporting and importing data 
 

Freemind gives you the option to export and import data. 
You will begin by learning about exporting data to different 
formats. 
 

7.1 Exporting data 
 

When you are working with Freemind, your maps are in 
“MindMap” mode. If you want to view the same map in a 
different format such as HTML, XHTML, or any picture 
format, you can use the export feature available in Freemind.  
 

Exporting to HTML 
 
It is possible to export an entire mind map or just a branch to 
HTML. Exporting to HTML also includes folding. Consider 
the “Article” mind map from chapter 2 as an example. 
 
Exporting a branch as HTML 
 
To export a branch as HTML, press Control+H. 
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Exporting a map as HTML 
 
To export a map as HTML, select File, and click Export. 
Choose the option As HTML. 
 
Freemind exports the map to HTML format. 

Figure 19 Exporting as HTML 

 

  

 
 

 

 

 
 
Exporting as XHTML (JavaScript version) 
 
XHTML is a general-purpose markup language that utilizes 
existing and future XML elements to present information on 
the WWW. XHTML focuses on structuring documents rather 
than presenting them, allowing online information to be 
presented in a variety of different forms, based on user need 
and device capability. 
 
To export a map as XHTML (JavaScript version), select File, 
and click Export. Choose the option As XHTML (JavaScript 
version). Save in a desired location by giving a name.  
 

Note: In the HTML format, clicking the ALL - option 
unfolds the individual nodes. Clicking the All+ 
option folds all the nodes. Click the “+” sign at the 
beginning of each node to display the descendants of 
that node. 
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Freemind exports the map to XHTML (JavaScript version) 
format. 

                           Figure 20 Exporting as XHTML (JavaScript version) 

 
Exporting as XHTML (Clickable map image version) 
 
You can use the XHTML (Clickable map image version) 
option to export a map with an overview picture to HTML. 
 
To export a map as XHTML (Clickable map image version), 
select File, and click Export. Choose the option As XHTML 
(Clickable map image version). Save in a desired location 
by giving a name.  
 
Freemind exports the map to XHTML (Clickable map 
image version) format. 

                           Figure 21 Exporting as XHTML (Clickable map image version) 
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Exporting as PNG or JPEG picture 
 
You can export a mind map as a PNG or JPEG picture. 
Consider the “Article” mind map from chapter 2 as an 
example. 
 
Exporting as PNG  
 
PNG (Portable Network Graphics) is a bitmapped graphics 
file format endorsed by the World Wide Web Consortium. 
PNG provides advanced graphics features such as 48-bit 
color, built-in color correction, tight compression, and the 
ability to display at one resolution and print at another. 
 
1. To export the map as PNG picture, select File, and click 
Export.  
 

2. Choose the option As PNG. Save the picture in the 
desired location by giving a name. 

 
      Freemind exports the map to PNG format. 

            Figure 22 Exporting as PNG  
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Exporting as JPEG 
 
JPEG (Joint Photographic Experts Group) is a compressed 
graphic file normally used for images that require many 
colors. The file name takes the form of filename. jpg. 
 
1. To export the map as JPEG picture, select File, and click 
Export.  

 
2. Choose the option As JPEG. Save the picture in the 
desired location by giving a name. 

 
      Freemind exports the map to JPEG format. 

      Figure 23 Exporting as JPEG 

                                   

Exporting to Open Office Writer document 
 
To export a map to an open office 1.4 writer document, select 
File, and click Export. Choose the option As Open Office 
Writer Document. 
 
Freemind exports the map to Open Office Writer document. 
 

7.2 Importing data 
 

You can import folder structures and Internet Explorer 
favorites into Freemind.  
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Importing folder structures 
 
1.  Go to File, click Import, and select the option Folder 
Structure. 

 
 Freemind displays a dialogue box stating “Select the 
folder to import”. 

 
2. Choose a suitable folder and click Open. 
 
 Freemind imports the structure of the folder to the 
desired location. 

 
Structure means the tree of all subfolders with links to the 
files in these subfolders. Consider the following example of 
the “Article” mind map having the imported structure of a 
folder stored in the system. The folder structure has been 
imported to the node “Due date”. 

           Figure 24 Importing folder structure 

 

Importing Internet Explorer favorites 
 
1. Go to File, click Import, and select the option Explorer 
Favorites. 

 
 Freemind displays a dialogue box stating, “Select the 
folder, in which your favorites reside”. 
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2. Enter the path to the folder Favorites, present on your 
disk. For example, on Windows 2000 the path is 
C:\Documents and Settings\<user>\Favorites. 

 
 Freemind imports the favorites to the selected node. 
 

7.3 Integrating with Word or Outlook 
 

You can paste an entire mind map or just a branch of a tree 
to another application that can understand a rich text format. 
When you transfer your maps, the text formatting and links 
are also pasted. You can paste Freemind maps into Microsoft 
Word, WordPad, or Outlook messages. 
 

Integrating your map with MS Word 
 
The best way of pasting a mind map into MS Word is 
exporting the map as HTML, and copying the HTML 
contents into MS Word document.  

 
1. Go to File, click Export, and choose the option As 
HTML.  

 
 Freemind exports the map as HTML. 
 
2. From the Edit menu of the HTML version, click Select 
All. Choose the option Copy. 

 
3. Open a new document in MS Word. Select Edit, and click 
Paste Special. 

 
 Word displays a dialogue box for Paste Special. 
 
4. Choose the option HTML format and click OK. 
 
 Freemind pastes the map into MS Word. 
 

Integrating your map with MS Outlook 
 
1. Select the node of your choice. Click Insert and select 
Hyperlink (Text Field). 
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2. Enter the link for e-mail based on the format given 
below: 

 mailto:johnsmith@hotmail.com 

 

Freemind confirms the e-mail link by adding a mail icon 
to the node. 
 

3. Click the e-mail link to create a new message. 
 
 Freemind opens the Outlook for creating a new message. 
 

8.0 Printing  
 

You can print by fitting the whole map into one page or by 
printing the map to several sheets of paper. Usually, the 
landscape option makes better use of space compared to the 
portrait. If you want to preview your map before you print it 
and have a Postscript printer or generic Postscript driver, 
you can print the map into a file. You can view the Postscript 
file with Ghost view or similar software. Beware that if you 
try to print to a file with a printer that does not understand 
Postscript, the resulting file will not be Postscript but 
probably PCL, which is unusable for you. If you have a very 
big map, you can export your map to HTML, and print it 
from your browser. You can also copy and paste the mind 
maps into Word or WordPad and print it. You can also 
export the map into HTML with headings, copy and paste it 
to MS Word, and print it from there. This method will also 
enable you to change styles, as you want. 
 

Printing your mind maps 
 
1. Click File and select Page Setup. 
 
 The Print Scaling dialogue box opens. 

       Figure 25 Print Scaling dialogue box 
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2. Select the option Fit to One Page or enter a Print Zoom 
Factor in the Print Scaling dialogue box. Click OK. 

 
 The Page Setup dialogue box opens. 
 
3. In the Orientation section, select Landscape to make 
better use of space. Adjust any other information as 
desired. Click OK. 

 
4. Click on File and select Print. 
 

9.0 Setting preferences 
 

Freemind gives you the option of customizing Freemind by 
setting your own preferences. These preferences can include 
language preferences, keyboard mappings and default font 
style, appearance and behavior when exporting to HTML, 
and many more categories. These changes become visible 
only when you restart Freemind. 
 
1. Click Tools, and choose the option Preferences. 
 
 The Freemind Properties dialogue box opens. 

                                Figure 26 The Freemind Properties dialogue box 
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2. Click the information categories on the left side, make the 
changes, and finally click Save. 

 
 Freemind saves the user preferences, which can be 
viewed by restarting. 

 

10.0 Using different modes 
 

Freemind is primarily a tool for editing mind maps, but it is 
also designed to be able to view data coming from various 
data sources. A programmer has to write a mode for every 
data source, to make that specific data source available for 
viewing in Freemind. 
 
There are 3 important modes in Freemind. Freemind 
displays all the maps in MindMap mode. There are 2 other 
modes called File and Browse modes. Unlike mind map 
mode, other modes are a demonstration of what is possible, 
rather than something actually in use. 
 

10.1 Browsing files on your computer 
 

The File mode is a demonstration that it is not difficult to 
feed data into a mind map from other sources. 
 

Browsing files on your computer 
 
To browse files on your computer, select Mode, and choose 
the option File. 
 
Freemind lets you browse the files in your computer as a 
mind map. 
 

Choosing the central node 
 
Use Center in the node context menu, to make a folder the 
central node of the map. 
 

Viewing or editing a file 
 
To view, edit, or execute a file, follow the link of its node. 
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10.2 Browsing mind maps 
 

This function is useful only in the Freemind applet. 
Browsing is the only thing you can do in the Freemind 
applet which can be uploaded to a website. 
 
To browse mind maps rather than to edit them, select Mode, 
and click Browse. 
 

11.0 Using rich text, pictures, and file locking 
 

In this section, you will learn about adding HTML in the 
nodes of your map. You will also learn about including 
pictures and experimental file locking features. 
 

11.1 Using rich text by means of HTML 
 

Nodes starting with <html> are rendered using the HTML 
contained in them. HTML is useful when you want to 
include lists, table, formatted text, foreground, or 
background colors in the nodes. 
 
Using HTML is convenient for publication on the web using 
the Freemind applet. There is no support for HTML in nodes 
and pictures in exporting to text or rich text format. Using 
the following HTML in nodes will produce a result as shown 
in the map. 
 
<html> 

<body bgcolor=#FFF68F> 

<ul> 

<li>Item 1</li> 

<li>Item 2</li></ul> 

</body> 

</html> 

 

<html> 

<body bgcolor=#FAEBD7> 

<b><i>This is an example of formatted text</i></b> 

</body></html> 
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                           Figure 27 Using rich texts by means of HTML 

 
11.2 Using pictures in nodes 
 

Addition of pictures is a very preliminary feature in 
Freemind. Freemind supports PNG, JPEG, and GIF picture 
formats. When you insert a picture in a node containing text, 
you will lose all the text you had in that node. Images 
inserted in this way are not correctly pasted outside 
Freemind, and they cannot be accurately exported to HTML. 
You can use relative links in the images. 
 

Inserting an image 
 
To insert an image into Freemind, click Insert, and select 
Image (File Chooser or Link). 
 
Freemind displays the Open dialogue box for you to specify 
the location of the image. 
 

Inserting images using HTML 
 
Using HTML in nodes is a more technical way of inserting 
an image. If the map and the image are in the same directory 
or location, it is sufficient to specify the name of the image in 
the node as given. 
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<html><img src=”image.jpg”></html> 

 

If the map and the image are in different directory or 
location, you must specify the exact location as given. 
 
<html><img src=”c:/Documents and Settings 

/user/Desktop/image.jpg”></html> 

 

You can drag and drop several image files into Freemind, 
select them as multiple nodes, and turn them to images by 
pressing Alt+K. 
 

11.3 Using experimental file locking 
 

Experimental file locking makes sure that multiple users do 
not edit the same mind map at the same time. This prevents 
them from accidentally overwriting the information written 
by each other. Experimental file locking is disabled by 
default. Current implementation of file locking does not 
perfectly prevent race conditions, but it should be fine for 
most of the practical purposes. 
 

Enabling Experimental File Locking 
 
1. Choose Tools from the menu bar. Select the option 
Preferences. 

 
 Freemind displays the Freemind Properties dialogue 
box. 

 
2. Click Environment. In the Files section, enable the 
option Experimental File Locking. 

 
3. Select the option Save, and restart the computer to 
activate the changes. 

 

12.0 The Freemind web applet 
 

Freemind web applet enables other users to view your mind 
maps from their browser. You can download and install the 
Java applet at your website, so that users having Java 1.4 or a 
higher version can browse through your maps. 
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12.1 Installing Freemind applet at your website 
 

You must download the applet Freemind-browser and 
install it. The downloaded archive contains 2 files 
freemindbrowser.jar and freemindbrowser.html. For Java 
security reasons, make sure that the applet jar file and the 
mind map are located at the same server. 
 
1. Copy the following link to your browser: 
 http://sourceforge.net/project/showfiles.php?group

_id=7118 

 

2. Download the applet Freemind-browser and install it. 
 
3. Create a link from your web page to 
freemindbrowser.html. 

 
4. In freemindbrowser.html, change the path to point to 
your mind map. 

 
5. Upload the Freemind applet jar file and your mind map 
file to the website. 

 

12.2 Using the Freemind applet 
 

You can only browse through the maps using the Freemind 
applet. You cannot edit or make changes to the mind maps. 
 

Folding and following a link 
 
Click the node to toggle folding or to follow a link. 
 

Moving a map 
 
Drag the background in the desired direction to move the 
map. 
 

Searching 
 
1.  To search for specific keywords, use the node context 
menu. Right click a node and select Node option. Click 
Find. 
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 Freemind displays the Input dialogue box. 
 
2. Enter the keywords for search and click OK. 
 
 Freemind searches the selected node for matching 
information. 

 

13.0 Keyboard shortcuts 
 

File commands 

New map                                    Ctrl+N 

Open map Ctrl+O 

Save map Ctrl+S 

Save as Ctrl+A 

Print Ctrl+P 

Close Ctrl+W 

Quit Ctrl+Q 

Previous map Ctrl+LEFT 

Next map Ctrl+RIGHT 

Export file to HTML Ctrl+E 

Export branch to HTML Ctrl+H 

Export branch to new MM file ALT+A 

Open first file in history Ctrl+Shift+W 

 

Edit commands 

Find Ctrl+F 

Fine Next Ctrl+G 

Cut Ctrl+X 

Copy Ctrl+C 

Copy Single Ctrl+Y 

Paste Ctrl+V 

 

Mode commands 

Mind map mode Alt+1 

Browse mode Alt +2 

File mode Alt+3 
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Node formatting commands 

Italicize  Ctrl+I 

Bold Ctrl+B 

Cloud Ctrl+Shift+B 

Change node color Alt+C 

Blend node color Alt+B 

Change node edge color Alt+E 

Increase node font size Ctrl+L 

Decrease node font size Ctrl+M 

Increase branch font size Ctrl+Shift+L 

Decrease branch font size Ctrl+Shift+M 

 

Node navigation commands 

Go to root  ESCAPE 

Move up UP 

Move down DOWN 

Move left LEFT 

Move right RIGHT 

Follow link Ctrl+ENTER 

Zoom out Alt+UP 

Zoom in Alt+DOWN 

 

New node commands 

Add sibling node ENTER 

Add child node INSERT 

Add sibling before Shift+ENTER 

 

Node editing commands 

Edit selected node F2 

Edit long node Alt+ENTER 

Join nodes Ctrl+J 

Toggle folded SPACE 

Toggle children folded Ctrl+SPACE 

Set link by file chooser CTRL+Shift+K 

Set link by text entry CTRL+K 

Set image by filechooser Alt+K 

Move node up Ctrl+UP 

Move node down Ctrl+DOWN 
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 Index 
 

A 

adding graphical links, 37 
adding hyperlinks, 33 
adding icons, 36 
adding pictures in nodes, 59 
applications of Freemind, 6 
applying styles, 21 
automatic layout, 24 

B 

blinking node, 25 

C 

child node, 15 
clouds, 32 
coloring options, 23 
copying, 42 
creating mind maps, 16 

D 

drag and drop, 41 

E 

edges, 15 
editing operations for the node, 19 
experimental file locking, 60 
exporting data, 48 
exporting as PNG or JPEG picture, 
51 

exporting to HTML, 48 
exporting to Open Office 1.4 
Writer document, 52 

F 

features of Freemind, 7 
folding and unfolding, 45 
formatting, 21 
Freemind interface, 14 
Freemind web applet, 60 

I 

icon, 35 
importing data, 52 
importing  Internet Explorer 
favorites, 54 

importing folder structure, 53 
inserting special symbols, 20 
installation, 9 
downloading and installing 
Freemind, 11 

downloading and installing JRE, 9 
integrating with Word or Outlook, 
54 

introduction to Freemind, 6 

K 

keyboard shortcuts, 62 

L 

linking to e-mail address, 35 
long node editor, 19 

M 

mind map, 6 
modifying edges, 25 
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N 

navigation features, 46 
changing to a different map, 47 
following links, 48 
moving around, 46 
scrolling, 47 
zooming, 48 

node, 15 

P 

pasting, 43 
physical style or patterns, 27 
printing, 55 

R 

removing a hyperlink, 34 
removing icons, 36 

root node, 15 

S 

saving  mind map, 18 
searching nodes, 29 
selecting multiple nodes, 40 
setting preferences, 56 
sibling node, 15 
splitting a long node, 19 

U 

using different modes, 57 
using rich text by means of HTML, 
58 

using Undo, 46 
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